EndNote X9 Desktop and OSCOLA 4th edition.

Part 1
Getting Started with EndNote and OSCOLA
Step-by-step instructions on how to use EndNote with the OSCOLA referencing style.

Contents

Part 1 Getting Started with EndNote and OSCOLA

Section 1: EndNote overview and key information

Section 2: Setting up and accessing your EndNote Library on a University PC

2.1 Opening EndNote

2.2 Saving your new Library

2.3 Opening your existing EndNote Desktop Library

2.4 Getting to know your EndNote Library

Section 3: Adding manual references to your EndNote Library

3.1 Opening a new reference template

3.2 Entering bibliographic information

3.3 Adding different reference types

3.4 Adding keywords and notes

Section 4: Exporting references from Library Search and subject databases

4.1 Exporting a reference from Library Search

4.2 Exporting a reference from Scopus

4.2.1 Selecting records

4.2.2 Importing into EndNote

4.3 Exporting a reference from subject databases

4.3.1 Westlaw UK
4.3.2 LexisLibrary ............................................................................................................................................................ 17

Section 5: Using the OSCOLA Referencing Style .................................................................................................................. 17

5.1 Choosing the OSCOLA Style ............................................................................................................................................. 18

Section 6: Inserting citations in Word ........................................................................................................................................ 18

6.1 EndNote tab ........................................................................................................................................................................ 18

6.2 Creating a document and inserting footnote-style citations .................................................................................. 19

6.3 Editing citations ................................................................................................................................................................... 21

6.4 Editing the full reference in a bibliography ........................................................................................................... 21

6.5 Adding subsequent citations to footnotes ......................................................................................................................... 21

Section 7: Bibliography .......................................................................................................................................................... 22

Section 8: Backing up your EndNote Library …………………………………………………………………………………………………… 24

Section 9: Accessing EndNote and getting help ........................................................................................................................... 25

9.1 Where can I access EndNote? ........................................................................................................................................ 25

9.2 Where can I get help with EndNote? ............................................................................................................................... 26


Section 10: The EndNote style .................................................................................................................................................... 27

10.1 How to use this guide .................................................................................................................................................. 27

10.2 Notes about this style .................................................................................................................................................. 27

10.3 Further information about OSCOLA .......................................................................................................................... 28

Section 11: EndNote reference types and OSCOLA heading numbers ............................................................................................................. 28

11.1 Cases ................................................................................................................................................................................ 29

11.2 Legislation (use the Statutes Reference) .......................................................................................................................... 31

11.3 Books .................................................................................................................................................................................. 31

11.4 Edited books and translated books .................................................................................................................................. 33

11.5 Contributions to edited books – use the Book section reference .............................................................................. 34

11.6 Encyclopaedias ................................................................................................................................................................. 35

11.7 Hard copy journal articles – use the Journals reference .................................................................................................. 36

11.8 Journal abbreviations .................................................................................................................................................... 37

11.9 Electronic journal articles and working papers – use the Electronic Article reference ................................................. 37

11.10 Conference papers ..................................................................................................................................................... 39

11.11 Theses ............................................................................................................................................................................. 39
11.12 Websites and blogs – use the Web page reference....................................................... 40
11.13 Newspaper articles...................................................................................................... 41
11.14 Personal Communications.......................................................................................... 42
11.15 General Reference Type............................................................................................... 43

Section 12: Making changes to the OSCOLA output style.................................................. 43

Section 13: OSCOLA bibliography templates...................................................................... 44
13.1 Footnote templates........................................................................................................ 44

Section 14: OSCOLA’s Quick Reference Guide................................................................. 44
14.1 Primary sources............................................................................................................... 44
14.1.1 Cases............................................................................................................................ 44
14.1.2 Statutes and Statutory Instruments........................................................................... 45
14.1.3 EU Cases.................................................................................................................... 45
14.1.4 EU Legislation............................................................................................................ 46
14.1.5 European Court of Human Rights.......................................................................... 46
14.2 Secondary sources.......................................................................................................... 46
14.2.1 Books......................................................................................................................... 46
14.2.2 eBooks......................................................................................................................... 47
14.2.3 Contributions to edited books.................................................................................. 47
14.2.4 Book reviews............................................................................................................. 47
14.2.5 Encyclopaedias........................................................................................................... 47
14.2.6 Dictionaries............................................................................................................... 47
14.2.7 Journal articles.......................................................................................................... 48
14.2.8 Online journals......................................................................................................... 48
14.2.9 Command Papers and Law Commission Reports.................................................. 48
14.2.10 Websites and blogs.................................................................................................. 48
14.2.11 Newspaper articles................................................................................................... 48
14.2.12 Podcasts, YouTube, etc........................................................................................... 48

For further information, including more detailed handouts and workbooks, go to: http://libguides.ncl.ac.uk/endnote.
Please note:

Newcastle University seeks to observe the highest standards of compliance with the law and the rights of rights holders, while publishing research and teaching resources to support our students and staff and contribute to academic practice.

If you are a rights holder and are concerned that you have found material on our website or legitimately under our name elsewhere, for which you have not given permission, or is not covered by a limitation or exception in laws of the UK or other countries (as relevant), please contact us in writing stating the following:

- your contact details.
- the full bibliographic details of the materials.
- the exact URL or other location where you found the material.
- proof that you are the rights holder and a statement that, under penalty of perjury, you are the rights holder or are an authorised representative.

Contact details:

Email: noticeandtakedown@ncl.ac.uk
Web: www.ncl.ac.uk/info/legal/takedown.html
Section 1: EndNote overview and key information.

An EndNote Library is where your references are stored. It is a single file which you save on your own file space – it has an .enl file extension (e.g. endnotelibrary.enl). However, when you create an EndNote Library (.enl file), it will automatically create a data folder which EndNote uses if you ever attach images or other files. You always need to make sure that that your .enl file and data folder are saved in the same location (preferably on your H:\ drive as this is backed up by NUIT four times a day). Please note that EndNote Libraries cannot be stored in cloud storage such as the University’s OneDrive). If the .enl file and .data folder are saved in different locations it is likely that your EndNote Library will not work.

It is possible to create several EndNote Libraries if you wish. However, we recommend creating one EndNote Library and using the Groups feature (see the task on Using Groups) to organise your references by topic/module/assignment or other criteria. This will allow you to synchronise your desktop EndNote Library with EndNote online should you wish to in the future. Setting up an EndNote desktop Library first, before syncing to EndNote Online, means that you authenticate your account as a Newcastle University student/staff member. This then means you have unlimited storage and access to specific Newcastle University referencing styles, as well as 2 years roaming access. A separate guide is available for using EndNote Online: https://libguides.ncl.ac.uk/endnote/teachonline.

EndNote can be a very useful time saving tool, but you do need to take time to learn how to use it properly. Otherwise, you risk corrupting your documents and losing valuable time. Go through this workbook step by step and practice using EndNote before using it in your own work.
Section 2: Setting up and accessing your EndNote Library on a University PC.

2.1 Opening EndNote.

Press the windows key on your keypad to summon the start menu or alternatively point your mouse in the screen’s bottom-left corner and then click on the windows symbol. EndNote should be listed under E. If you can’t see the EndNote program press the Windows Key + X and select Search.

The first time you use EndNote you may see a screen inviting you to sign up to EndNote online or synchronise your Library (if required this can be done later. Check out our EndNote Online workbook for more details: https://libguides.ncl.ac.uk/endnote/teachonline).

There may also be other ‘pop up’ boxes. Close these boxes using the cross in the top right corner of the pop-up window or by selecting ‘ignore this’.
If this is the first time you have used EndNote, you will need to create a new Library or open an existing Library. Click on **File**, then **New** to create a new Library:

![Image of EndNote](image)

### 2.2 Saving your new Library.

A new window will appear called **New Reference Library**.

Navigate to your own file space (**your H:\ drive**) and locate or create a suitable folder in which to save your Library. In the File name box call the new Library: (Your Name)’s Library (default), as well as the creation date e.g. Joe Bloggs Library 06072019. This will help you to manage your Library well and keep track of your EndNote files.

Ensure the Save as type box is displaying: **EndNote Library (*.enl)**

Click on **Save**:

![Image of New Reference Library](image)
Your new EndNote Library will then open – you currently have no references to display.

When you create an **EndNote Library (.enl file)**, the process will also create a folder (**.Data file**). This is what EndNote uses if you attach images or other files to a reference. Make sure that your .enl file and data file are always saved in the same location, otherwise your Library will not work properly.

### 2.3 Opening your existing EndNote Desktop Library.

Your EndNote Library will be securely saved in your own network space or H:\ drive.

If you have the EndNote shortcut saved to your desktop, start menu or taskbar, click on this icon (or alternatively press the windows key and select EndNote from the menu):

To open the library simply go to your H:\ drive and look for the EndNote icon and double click to open (see example below):
2.4 Getting to know your EndNote Library.

Note that your EndNote Library has the following features:

Groups pane: you can create groups to organise your references or EndNote will sometimes create temporary ‘autogroups’ for example when importing references or working with a Word document.

Reference pane: your references will be listed here and can be sorted using the headings at the top. These headings can be reordered by dragging and dropping or changed by right-clicking on the headings and ticking/unticking fields.

Reference preview pane: this has several options. Notice you can alter the layout and show/hide panes using the layout button at the bottom of the screen.

Display modes: these allow you to switch between working with only your local EndNote Library, with your Library and online databases, or with databases alone.

Referencing style: you can choose which style you want by clicking here and choosing ‘Select another style’. Search using a keyword or scroll down, click on your required style, then select ‘choose’.

It is possible to resize your Library window using the maximize/minimize buttons in the top-right corner or using the resize handle in the bottom-left – hold your mouse over it until your cursor becomes a double-sided arrow, then simply drag to resize.
Section 3: Adding manual references to your EndNote Library.

3.1 Opening a new reference template.

With your EndNote Library open, click on the New Reference icon in the top menu:

This will open a New Reference window, with a template form to complete the reference details. You do not need to complete all fields in the reference template but to create a usable reference and accurate record, there are key fields to complete.

Notice that Journal Article is the default reference type.

3.2 Entering bibliographic information.

Start by entering details of the article’s author. Note that each author’s name must be added on a new line. Take care that the spaces, punctuation, and upper and lower cases are formatted as described. This will ensure that EndNote is able to correctly format the author details in your chosen referencing style.

- Type in the first author Watson, Irene and press enter/return.
• On a new line, type in the **second author** Smith, Rhona

Now enter the other available bibliographic details, using the TAB key to move between fields:

- **Year**: 2002
- **Title**: Buried Alive
- **Journal**: Law and Critique
- **Volume**: 13
- **Issue**: 3
- **Pages**: 253

To save the reference, click on **File > Close reference**. This will close the reference and the changes will be saved automatically. You can also use the cross in the top-right to close the reference.

You may see a pop-up window asking if you want to save your changes. Tick **Do not display this message again** and click **Yes**. From now on, your changes will be saved automatically whenever you close a reference.
3.3 Adding different reference types.

Click on CTRL and N (this is a shortcut) to bring up a blank New Reference window.

From the Reference Type menu, select Web Page. This will bring up a different template form, with fields that are most relevant for this type of reference.

Enter the following information, and then close the reference to save it.

- **Author**: The Law Society,

Note that a corporate author requires a comma entering after the name (The Law Society,), otherwise EndNote will format the author’s name into last name/initials format e.g. Author: Society, TL.

- **Year**: 2016
- **Title**: Making a Will
- **Publisher**: The Law Society
- **Access date**: 8 September 2019
- **Last update**: June 2016
- **URL**: www.lawsociety.org.uk/for-the-public/common-legal-issues/making-a-will

Note that if a web address does not begin with ‘www’ you would need to add ‘http://’ at the start of the address.

3.4 Adding keywords and notes.

This function allows you to put comments or keywords into references so that you can search for them by criteria that suit your needs. You must separate each keyword by a semi-colon or place each on a new line. The keywords will not appear in references when you export them as footnotes or bibliographies.

Double-click on the Making a Will reference to open the reference.

In the Keywords field, type *Probate; intestacy; executors* on separate lines and close the reference.

Go to Tools and Search Library.

At the Search box, change Author to Keywords using the drop-down menu.

Type *probate* in the search box and click on Search.

Click on Hide Search Panel on the right of the Toolbar to return to your default screen.

**Please note**: you would use the research notes field to store personal reminders, such as the location of a quotation in a book or the quotation itself.
Section 4: Exporting references from Library Search and subject databases.

4.1 Exporting a reference from Library Search.

Recommended for books, eBooks and titles found in 'Everything except articles' search option.

Go to Library Search libsearch.ncl.ac.uk and into the search box, type in the keywords you have generated in your search strategy.

Click on search. You should see a list of results.

Click on the title of the book that you wish to export to EndNote. Scroll to the Send To: options. Click on EndNote RIS and then Download.
A small window will open at the bottom of your chosen browser (Push to RIS or Import to Citation Manager).

**Internet Explorer**: Click on **Save** and then **Open**.

![Download window](image)

Google Chrome: Click on the file and it will begin the import automatically:

![File download window](image)

You may be asked to choose a destination. Click **OK** to choose EndNote as your destination and you will see the reference added to your EndNote Library:

![Reference import window](image)

**Please note**: when exporting from Library Search, please always check that the reference has imported correctly as occasionally eBooks may be imported as ‘Generic’ resource types and author names occasionally import into the ‘Editors’ field in EndNote.

### 4.2 Exporting a reference from Scopus.

#### 4.2.1 Selecting records.

Go to the Library homepage [ncl.ac.uk/library/](http://ncl.ac.uk/library/). In the Library Search box type **Scopus** and click on the search icon. Locate the database in your results list and click on the **database title** and then the blue Scopus button under **View online**. This will open Scopus in a new window.

In the Scopus search box type “**essay writing**” and click on search. Mark some of the records by ticking the checkboxes.
4.2.2 Importing into EndNote.

At the top of the page, click on the Export icon and you will be taken to a page where you will be asked to select the output format and what level of detail you would like to import into EndNote. You will then see the Export Document Settings Page. Choose RIS format and select the level of information that you would like brought into your EndNote Library (our advice would be to export all the information). The ones that will transfer over will have an orange box next to them. Click on the Export button:
A file download window will appear at the bottom of your browser to allow you to automatically add the references to your open Library. The references will be added as Unfiled references.

### 4.3 Exporting a reference from subject databases.

Each subject database will have a slightly different way to export references into EndNote. Use the help section within each subject database you are using to find guidance on exporting to different reference management tools, including EndNote.

#### 4.3.1 Westlaw UK.

One of the main legal databases in use at Newcastle University is Westlaw UK. Westlaw’s Legal Journals Index (LJI) comprehensively indexes most UK legal journals from 1986 onwards. Westlaw will **only** allow the download of journal article references to EndNote, not cases or legislation.

Once you have located a journal article reference you wish to export to EndNote, you will find the **Export to EndNote** function near to the standard email/print/download options.

![Westlaw UK screen capture](image)

**Please note:**

Westlaw puts their version of the citation in the ‘Alternate Title’ field, and it appears in your reference (that field is connected to journal abbreviations in Endnote). You must delete that line from the reference in EndNote.

You may have to add the volume number (if there is one) to the volume number field as Westlaw does not export this detail.
As with other journal downloads, you also have to remember to add the year to either ‘Add year here if there is a volume number’ or ‘Add year here if there is NO volume number’, so that you will get parentheses or square brackets around the year respectively.

[Credited to Sandy Meredith, 17 February 2012.]

4.3.2 LexisLibrary.

LexisLibrary does not support export of references to EndNote, only RefWorks. We recommend you create a new reference manually if you wish to save a reference from this resource.

Section 5: Using the OSCOLA Referencing Style.

Styles dictate the layout of a reference of an in-text citation and bibliography. EndNote provides over 5,000 different styles, many relating to specific journals. Newcastle Law School uses OSCOLA (Fourth edition), the Oxford University Standard for the Citation of Legal Authorities, which is a footnote style.
5.1 Choosing the OSCOLA Style.

In EndNote...and in Word...

Click on the **Output style** menu – this is where you can select your preferred style.

Click on **Select Another Style**.

![Select Another Style](image)

The Select Another Style window lists the 500 most commonly used styles.

Scroll through the list.

Highlight **OSCOLA_4th_edn** and click on **Choose**.

It will be saved in your Favourites, which means it will show up in the Output style menu next time you use EndNote.

**Note**: Do not choose the OSCOLA 4th Style option. This has now been superseded.

---

**Section 6: Inserting citations in Word.**

EndNote and Word can be used together to create in-text citations and bibliographies in your documents. This uses EndNote's Cite While You Write feature. This task will give you an introduction to this feature. You will need to open both Word and EndNote in order for them to work together.

This task is written for Word 2016 or later.

6.1 **EndNote tab.**

Click on the Windows button on your PC and select **Microsoft Word**.

Notice you have an **EndNote tab** in the ribbon at the top of the screen:
6.2 Creating a document and inserting footnote-style citations.

In your blank Word document type:

“It has been argued by many thinkers that planning is essential when writing an essay.”

Ensure your cursor is at the end of the sentence after the full stop – this is where the in-text citation will go.

Click on References > Insert Footnote.

A small number 1 (known as a superscript number) will appear within your text but also in a footnote at the bottom of the page. Your cursor will move to the footnote and this is where your reference will be inserted.

Now, from the EndNote ribbon click on ‘EN Go to EndNote’.

This will take you to EndNote and creates a working link between your Word and EndNote files.

Click on a reference in your EndNote Library to highlight it.
Then click on the **Insert Citation icon** in the toolbar.

The reference will appear as a footnote at the bottom of the page.


It will also be inserted at the end of your document for your bibliography. The bibliography will be sorted by reference type so all books are listed together, all cases together, etc.

Add some more text to your document and try adding some more citations to see how the reference list grows.

**Notice** that EndNote automatically creates a Group for your document as you write. This is a temporary group which disappears when you close Word.
6.3 Editing citations.

You can amend individual citations in your text, for example to add page numbers or to exclude the author or year. You may need to edit a citation if the author’s name appears in the wrong order and does not comply with OSCOLA.

You may also need to add a pinpoint or a full stop to your footnote.

Place the cursor in the text on the citation you wish to amend. Click on Edit & Manage Citations in the EndNote ribbon in Word.

On the Edit Citation tab, and within the Suffix box type: 87 (do not use the pages option as this does not work in all the styles). Click OK.

Note: You can also use this suffix box to add the full stop that is required after every footnote, as required by the OSCOLA style.

Please do NOT edit footnotes manually within Word, and only use the tools available to you within the EndNote tab, or your document will become CORRUPTED.

You can also delete citations using this function Edit & Manage Citations under Edit Reference, select Remove Citation.

6.4 Editing the full reference in a bibliography.

If you need to amend a reference, for example if you have made a mistake when entering it into EndNote, it is possible to do this from within Word, so that your document will instantly reflect the changes.

Place the cursor in the text on the citation for the reference you wish to amend. Click on Edit Library Reference in the EndNote ribbon in Word.

In the EndNote Reference window make your amendments (e.g. change the date in the Year field).

Close the reference and Save the changes.

Go back to your Word document and note that the changes have been made. You may need to wait a moment for the change to take effect – if it does not update click Update Citations and Bibliography.

6.5 Adding subsequent citations to footnotes.

If you want to refer to the same source a second (or more) time, there is a way of briefly referring to the source rather than having to repeat a full reference again. This is done by providing a cross-citation in brackets to the footnote in which the full citation can be found.
If the subsequent citation is in the footnote immediately following the full citation, you can generally use ‘ibid’ (lower case) instead.

This example shows a citation of a book which is first cited (in full) in footnote 1, cited again in footnote 26, with a cross-citation to footnote 1 and a pinpointed page, and then cited again at footnote 27:

1 Robert Stevens, Torts and Rights (OUP 2007).

26 Stevens (n 1) 110.

27 ibid 271-278.

Please note:

In the case of subsequent citations immediately following the full citation in footnotes, EndNote will automatically insert ibid. Simply add the citation again as you would normally.

Note: EndNote may insert Ibid (with a capital ‘I’). You will need to edit this once you have completed your work to comply with the OSCOLA style.

If the pinpoint is different, you will need to edit the citation (using Edit & Manage Citations).

If the subsequent citation does not immediately follow in the footnotes, EndNote will insert a brief citation and you will need to edit the citation to add details such as the original footnote number (n X) and pinpoint (EndNote X9 tab > Edit & Manage Citations and type in the Suffix box > click OK).

To find out more and to access additional support on the above, please go to the OSCOLA section on the EndNote Library Guide: http://libguides.ncl.ac.uk/endnote/oscola.

Section 7: Bibliography.

If you want to change the title of the bibliography, or the spacing or any type of formatting, then you need to do this through the EndNote X9 tab in Word. Click on the small box with an arrow next to the word ‘Bibliography’ in the EndNote ribbon. Change the details and then click on ‘OK’.
EndNote will direct your references in your final bibliography to be arranged by reference type in alphabetical order, and within each reference type by Author. All books will be listed together, then cases, then journal articles, etc. depending on which reference types you have chosen.

When you come to printing your final bibliography, you may want to add headings to make it clear which references are books, because they were created under the reference type Edited Book. If you want to do this, you will need to convert your document to plain text. Go to Convert Citations and Bibliography > Convert to Plain Text.

EndNote will ask you to save this as a new document, so as to keep a copy of your original document with your EndNote field codes in (the invisible code that connects your EndNote Library to your Word document). Name the document appropriately, e.g. Document 1_plain text. This new document is now unconnected to your EndNote Library and therefore you can make as many changes as needed to the text, footnotes or bibliography without any worry that it will become corrupted.

If you want to add further citations to your document, you can either do it manually or go back to your original document with the Endnote field codes in and work within that, before converting to Plain Text once more.
If you want to print out your bibliography separately from your Word document, you can create and print a separate bibliography. To do this:

Open your EndNote Library. Click on **Edit > Select All**.

**Select your required style** from the current style menu in the top right-hand corner by clicking on the down arrow.

Right-click on the highlighted references and click on **Copy Formatted**.

Open a Word document and paste the references into it.

---

**Section 8: Backing up your EndNote Library.**

Even if you are saving your EndNote Library on your H:\ drive and it is being backed up by NUIT four times a day, it is still wise to make a manual back up of your Library, especially when you have entered a significant amount of data or exported a lot of references.

To make a backup Library, open your EndNote Library and then click on **File > Compressed Library**.

You will then get a dialog box where you can select what your compressed Library will include. We advise that you select all references with file attachments, as this will ensure all your work is saved.
Click on **Next** and name your compressed Library appropriately (you may want to call it ‘My EndNote Library compressed’ or ‘Back up My EndNote Library’). **Choose an appropriate place to save the compressed Library** (we advise that you save it on your H:\ drive, alongside your other Libraries) and then click on ‘Save’.

<table>
<thead>
<tr>
<th>Name</th>
<th>Date modified</th>
<th>Type</th>
<th>Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>Joe Bloggs Library 06072019.Data</td>
<td>03/07/2019 14:53</td>
<td>File folder</td>
<td></td>
</tr>
<tr>
<td>Back up Joe Bloggs Library 06072019</td>
<td>10/09/2019 12:48</td>
<td>Archived EndNote...</td>
<td>21 KB</td>
</tr>
<tr>
<td>Joe Bloggs Library 06072019</td>
<td>03/07/2019 14:53</td>
<td>EndNote Library</td>
<td>0 KB</td>
</tr>
</tbody>
</table>

And remember, if you are copying or moving your Endnote Library, remember there are two files that make up your Library - the main .enl file and supporting .DATA file - you require both!

### Section 9: Accessing EndNote and getting help.

#### 9.1 Where can I access EndNote?

You can access EndNote in a variety of different ways. These include:

- **Via all the PC clusters in the University.** EndNote can be installed on any freestanding University-owned machine. Please contact NUIT if it’s not installed on the PC you are working on.

- **By downloading the EndNote software onto your own laptop/PC.** You will be responsible for deleting this piece of software when you leave the University. To request a copy, go to [https://services.ncl.ac.uk/itservice/core-services/software/licences/bibliographical/endnotewinmac.html](https://services.ncl.ac.uk/itservice/core-services/software/licences/bibliographical/endnotewinmac.html) and fill in the EndNote Personal Use Request form.

- **Via the Remote Application Server (RAS) [http://ras.ncl.ac.uk/](http://ras.ncl.ac.uk/).** If you are accessing EndNote via RAS you also need to use Microsoft Word and Library Search via RAS as well (rather than using your own version of Word). This is because the RAS version has the EndNote ribbon already installed.

- **By buying your own personal copy of the latest EndNote** from Bilaney Consultants: [https://www.bilaney-consultants.co.uk/our-products/endnote.html](https://www.bilaney-consultants.co.uk/our-products/endnote.html). Students with a valid ID will get a student discount.
9.2 Where can I get help with EndNote?

There are lots of different ways you can get further help with EndNote, but we suggest you do the following in this order:

- Go to the Newcastle University EndNote Library Guide: https://libguides.ncl.ac.uk/endnote.
- See if there is a FAQ which answers your question (simply type in the search box or click on ‘Endnote’ in the word cloud and browse through the FAQs): https://libhelp.ncl.ac.uk/.
- If you are still struggling please contact us through Library Help by submitting a question, taking part in a live chat or emailing us at libraryhelp@ncl.ac.uk. All the details can be found on the Library Help page: https://libhelp.ncl.ac.uk/.
Part 2
EndNote Style Guide

A reference section listing a range of resource types and how these should be entered into EndNote.

Section 10: The EndNote style.

This style available at Newcastle University is the Basic/web/server style for OSCOLA (OSCOLA_4th_edn). This is the most recent style. This style guide includes the minor updates contained within the 2012 OSCOLA update, as distributed by Oxford University.

More information on the OSCOLA style is available on their website; www.law.ox.ac.uk/research-subject-groups/publications/oscola.

10.1 How to use this guide.

- Follow the instructions for each reference type, using only the reference types listed, and only the fields indicated for each reference type.
- The formatting for each reference type is shown in a box, followed by examples of formatted footnote references and the data in the relevant fields in the reference.
- (Note that in bibliographies, the initials follow the surname – this is how the entry will appear in the Endnote Preview box).
- Some Endnote reference types are suitable for more than one type of reference – see the 'Endnote reference types and OSCOLA heading numbers' table and 'Also use for' suggestions.

10.2 Notes about this style.

- Capitalise major words in titles (for cases, statutes, journal articles, books, reports etc.; e.g. The History of Time).
- Only Reference Types that are formatted as described will show the reference appropriately. Text in Reference Types not included in the list below will appear in the Generic format.
- Text in fields not included in the formatting will not appear in the footnote or the bibliography, however it is not necessary to have text in all the formatted fields.
• The year is not included in several formats; however, it may be useful to include it in the reference so that your Library can be organized by date, or for when reformatting your references in other styles.
• Use Edit Citation/Suffix or Edit Citation/Pages to add pinpoints/page numbers, section and subsections, notes, cross references etc, or simply add these details in the footnote outside the ‘grey’ Endnote field. Bear in mind that the Edit Citation/Pages function only allows insertion of spaces and numbers. When cross- referencing to an earlier footnote use Edit Citation/Suffix.

10.3 Further information about OSCOLA.

More information about using OSCOLA style for referencing in EndNote, including examples, can be found in the next pages of this guide. The information is from OSCOLA 4th edn EndNote Style by Sandra Meredith, Faculty of Law, University of Oxford. It is included with the author’s permission.

• This guide is also available from Oxford University’s OSCOLA webpages at: www.law.ox.ac.uk/research-subject-groups/publications/oscola-styles-endnote-latek-refworks-and-zotero.
• For more detailed information on OSCOLA see: www.law.ox.ac.uk/research-subject-groups/publications/oscola-styles-endnote-latek-refworks-and-zotero.
• For OSCOLA EndNote FAQs see: www.law.ox.ac.uk/oscola-faqs.
• You might find Cardiff University’s online tutorial on citing references in OSCOLA style useful. See: https://xerte.cardiff.ac.uk/play_6716.
• To ensure you use the correct abbreviation for journal names, consult a reliable source such as the Cardiff Index to Legal Abbreviations: www.legalabbrevs.cardiff.ac.uk/.

Section 11: EndNote reference types and OSCOLA heading numbers.

<table>
<thead>
<tr>
<th>EndNote reference type</th>
<th>OSCOLA heading number</th>
<th>OSCOLA reference type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cases (p. 32)</td>
<td>2.1, 2.2, 2.3, 2.6.2, 2.6.3, 2.7, 2.8</td>
<td>all cases.</td>
</tr>
<tr>
<td>Statute (p. 33)</td>
<td>2.4, 2.5, 2.6.1, 3.2.5, 3.4.2, 3.4.5</td>
<td>primary and secondary legislation, Hansard, European Commission documents, books of authority and institutional works that have no author, and any sources without an author that should be presented entirely in Roman font.</td>
</tr>
<tr>
<td>Book (p. 34).</td>
<td>3.2.1, 3.2.2, 3.2.5, 3.4.3, 3.4.4</td>
<td>authored books, older works, books of authority and institutional works that have an author, Command Papers, Law Commission reports and any documents that require authors, titles in italics and bibliographic information in brackets.</td>
</tr>
<tr>
<td>Edited book (p. 36).</td>
<td>3.2.2</td>
<td>edited and translated books.</td>
</tr>
<tr>
<td>Book section (p. 37).</td>
<td>3.2.3, 3.2.6</td>
<td>contributions to edited books, and encyclopaedias where the author of an entry should be included in the reference.</td>
</tr>
<tr>
<td>Encyclopaedia (p. 39).</td>
<td>3.2.6</td>
<td>encyclopaedias such as <em>Halsbury’s Laws</em>, where the author is not included in the reference.</td>
</tr>
<tr>
<td>Journal article (p. 39).</td>
<td>3.3.1, 3.3.2</td>
<td>all journal articles that are published in hard copy, even if sourced online, and case notes.</td>
</tr>
<tr>
<td>Electronic article (p. 41).</td>
<td>3.3.4, 3.3.5</td>
<td>all journal articles that are only published online and working papers.</td>
</tr>
<tr>
<td>Conference paper (p. 43).</td>
<td>3.4.5</td>
<td>conference papers.</td>
</tr>
<tr>
<td>Theses (p. 44).</td>
<td>3.4.7</td>
<td>theses.</td>
</tr>
<tr>
<td>Web page (p. 45).</td>
<td>3.4.8</td>
<td>websites and blogs.</td>
</tr>
<tr>
<td>Newspaper article (p. 46).</td>
<td>3.4.9</td>
<td>newspaper articles, including online newspaper articles.</td>
</tr>
<tr>
<td>Personal Communication (p. 47).</td>
<td>3.4.11, 3.4.10</td>
<td>emails, letters, interviews and any source that requires a title with neither quote marks nor italics, and the date</td>
</tr>
<tr>
<td>Generic (p. 47).</td>
<td></td>
<td>any reference that requires an author, the title in italics, bibliographic information about the source (i.e., where it was published) and year of publication.</td>
</tr>
</tbody>
</table>

### 11.1 Cases.

- **Case Name field**: put the party names in Roman (i.e. not italic) font.
- **Reporter field**: put the full citation -- neutral citation if available, year of judgment, report abbreviation and first page – with punctuation. If the case is unreported, put the court and date in brackets in the Reporter field.
- **Court field**: put the court abbreviation. This is only required if the case doesn’t have a neutral citation and is after 1865. Do not insert brackets.
- **Call Number field** for ECJ Case Numbers.
- For other cases, use any of the fields noted above. The information will appear as shown in the format box below.
- You may wish to use the **Abbreviated Case Name field** for text for subsequent citations – generally this will be a short form of the party names.

**Cases format for footnote**: Call Number *Case Name* Reporter (Court).

**Cases format for bibliography**: *Case Name* Call Number Reporter (Court)

<table>
<thead>
<tr>
<th>EndNote reference example: case with neutral citation</th>
<th>EndNote reference example: ECJ case</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Case Name</strong> Malcolm v DPP <strong>Reporter</strong> [2007] EWHC 363 (Admin), [2007] 1 WLR 1230</td>
<td><strong>Case Name</strong> Arne Mathisen AS v Council <strong>Reporter</strong> [2002] ECR I-2905 <strong>Call number</strong> Case T-344/99</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>EndNote reference example: case with report only</th>
<th>EndNote reference example: unreported case without neutral citation</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>Page v Smith</em> [1966] AC 155 (HL)</td>
<td><em>Stubbs v Sayer</em> (CA, 8 November 1990)</td>
</tr>
<tr>
<td><strong>Case Name</strong> Page v Smith <strong>Reporter</strong> [1966] AC 155 <strong>Court</strong> HL</td>
<td><strong>Case Name</strong> Stubbs v Sayer <strong>Reporter</strong> (CA, 8 November 1990)</td>
</tr>
</tbody>
</table>
11.2 Legislation (use the Statutes Reference).

- **Name of Act field**: put the full name (including the year and any identifying numbers) of the Bill, Act, SI, Treaty etc. If citing Council Directives, Regulations and Commission documents, include the citation.
- **Short Title field**: insert suitable text for use in subsequent citations.

Also use Statutes for: Hansard, parliamentary reports, European Commission documents and any sources without an author that should be in Roman font.

**Statutes format for footnote**: Name of Act.

**Statutes format for bibliography**: Name of Act

<table>
<thead>
<tr>
<th>EndNote reference example: UK Act</th>
<th>EndNote reference example: EU Directive</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name of Act</strong></td>
<td><strong>Name of Act</strong></td>
</tr>
</tbody>
</table>

11.3 Books.

- **Author field**: put the author’s name in the form Susan D Smith or Smith, Susan D. If there is more than one author, put each author on a new line. If the author is an organization, such as Law Commission, put a comma after the organization name.
- **Year field**: put the year of publication of the version/edition you are citing (i.e. not year of first publication etc.).
- **Title field**: put the title with capital letters for the major words.
- **Series Title field**: use this field for any additional information, such as editor(s), translator(s) or when the book was first published.
- **Publisher field**: put the publisher of the version/edition you are citing.
- **Volume field**: enter the volume number in numerals here if the publication details of successive volumes vary (e.g. different year or publisher).
- **Edition field**: put the edition of version/edition you are citing, using the form 2nd, 3rd, 4th etc, or rev for revised editions.
- **Short Title field**: if required for subsequent citations of a book, enter a short title.
Also use for: Reports, Command Papers, Law Commission Reports, and any documents with authors, titles in italics and bibliographic information in brackets.

**Book format for footnote:** Author _Firstname_ Author _Lastname_, *Title*, Volume (Series Title, Edition edn, Publisher Year).

**Book format for bibliography:** Author _Lastname_ Author _Initials_, *Title*, Volume (Series Title, Edition edn, Publisher Year)

<table>
<thead>
<tr>
<th>EndNote reference example: book</th>
<th>EndNote reference example: translated book</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Author</strong></td>
<td><strong>Author</strong></td>
</tr>
<tr>
<td>Gareth Jones</td>
<td>Zweigert, H</td>
</tr>
<tr>
<td><strong>Year</strong></td>
<td><strong>Year</strong></td>
</tr>
<tr>
<td>2009</td>
<td>1998</td>
</tr>
<tr>
<td><strong>Title</strong></td>
<td><strong>Title</strong></td>
</tr>
<tr>
<td>Goff and Jones: The Law of Restitution</td>
<td>An Introduction to Comparative Law</td>
</tr>
<tr>
<td><strong>Series Title</strong></td>
<td><strong>Series Title</strong></td>
</tr>
<tr>
<td>1st sup</td>
<td>Tony Weir tr</td>
</tr>
<tr>
<td><strong>Publisher</strong></td>
<td><strong>Publisher</strong></td>
</tr>
<tr>
<td>Sweet &amp; Maxwell</td>
<td>OUP</td>
</tr>
<tr>
<td><strong>Edition</strong></td>
<td><strong>Edition</strong></td>
</tr>
<tr>
<td>7th</td>
<td>3rd</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>EndNote reference example: book with volumes</th>
<th>EndNote reference example: other singularly published report</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Author</strong></td>
<td><strong>Author</strong></td>
</tr>
<tr>
<td>von Bar, Christian</td>
<td>Julian V Roberts</td>
</tr>
<tr>
<td><strong>Year</strong></td>
<td><strong>Year</strong></td>
</tr>
<tr>
<td>2000</td>
<td>Mike Hough</td>
</tr>
<tr>
<td><strong>Title</strong></td>
<td><strong>Title</strong></td>
</tr>
<tr>
<td>The Common Law of Torts</td>
<td>2009</td>
</tr>
<tr>
<td><strong>Publisher</strong></td>
<td><strong>Title</strong></td>
</tr>
</tbody>
</table>

---

University Library. Explore the Possibilities.
11.4 **Edited books and translated books.**

- **Editor field:** put the editor or translator’s name in the form Susan D Smith or Smith, Susan D. If there is more than one editor/translator, put each on a new line. If the editor is an organization, such as Law Commission, put a comma after the organization name.
- **Year field:** put the year of publication.
- **Title field:** put the title with capital letters for the major words.
- **Series Title field:** use this field for any additional information, such as editor(s), translator(s) or when the book was first published.
- **Publisher field:** put the publisher of the version/edition you are citing.
- **Volume field:** enter the volume number in numerals here if the publication details of successive volumes vary (e.g. different year or publisher).
- **Edition field:** put the edition of version/edition you are citing, using the form 2nd, 3rd, 4th etc, or rev for revised editions.
- **Short Title field:** if required for subsequent citations of a book, enter a short title.

**Note:** For translations, such as *The Institutes of Justinian* example below right, de-link the document from EndNote when your work is complete, and replace (eds) with (trs), OR copy and paste the reference from the Preview window in Endnote and adjust it.

**Edited book format for footnote:** Editor Forename Editor Surname (ed/eds), *Title*, Volume (Series Title, Edition edn, Publisher Year).

**Edited book format for bibliography:** Editor Surname Editor Initials (ed/eds), *Title*, Volume (Series Title, Edition edn, Publisher Year)

**Editor**
Jeremy Horder

**Year**
2000

**Title**
Oxford Essays in Jurisprudence: Fourth Series

**Publisher**
OUP

Peter Birks and Grant McLeod (trs), *The Institutes of Justinian* (Duckworth 1987)

**Editor**
Peter Birks
Grant McLeod

**Year**
1987

**Title**
The Institutes of Justinian

**Publisher**
Duckworth

11.5 **Contributions to edited books – use the Book section reference.**

- **Author field:** put the author’s name in the form Susan D Smith or Smith, Susan D. If there is more than one author, put each author on a new line.
- **Year field:** put the year of publication.
- **Title field:** put the title with capital letters for the major words.
- **Editor field:** put the editor’s name in the form Susan D Smith or Smith, Susan D. If there is more than one editor, put each author on a new line. If the editor is an organization, such as Law Commission, put a comma after the organization name.
- **Book Title field:** put the book title in Roman with capital letters for the major words.
- **Series Title field:** use this field for any additional information, such as editor(s), translator(s) or when the book was first published.
- **Publisher field:** put the publisher of the version/edition you are citing.
- **Volume field:** enter the volume number in numerals here if the publication details of successive volumes vary (e.g. different year or publisher).
- **Edition field:** put the edition of version/edition you are citing, using the form 2nd, 3rd, 4th etc, or rev for revised editions.
- **Short Title field:** if required for subsequent citations of a book, enter a short title.

*Also use for:* encyclopaedias when the author of an entry should be included in the reference.

**Contribution to edited book format for footnote:** Author _Firstname Author_Lastname_, ‘Title’ in Editor (ed/eds), *Title*, Volume (Series Title, Edition edn, Publisher Year).

**Contribution to edited book format for bibliography:** Author _Lastname Author_Initials, ‘Title’ in Editor (ed/eds), *Title*, Volume (Series Title, Edition edn, Publisher Year)
<table>
<thead>
<tr>
<th>EndNote reference example: book chapter</th>
<th>EndNote reference example: authored encyclopaedia entry</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Author</strong></td>
<td><strong>Author</strong></td>
</tr>
<tr>
<td>John Cartwright</td>
<td>Friedrich, CJ</td>
</tr>
<tr>
<td><strong>Year</strong></td>
<td><strong>Year</strong></td>
</tr>
<tr>
<td>2009</td>
<td>1968</td>
</tr>
<tr>
<td><strong>Title</strong></td>
<td><strong>Title</strong></td>
</tr>
<tr>
<td>The Fiction of the Reasonable Man</td>
<td>Constitutions and Constitutionalism</td>
</tr>
<tr>
<td><strong>Editor</strong></td>
<td><strong>Book Title</strong></td>
</tr>
<tr>
<td>AG Castermans</td>
<td>International Encyclopedia of the Social Sciences III</td>
</tr>
<tr>
<td>J Hijma</td>
<td></td>
</tr>
<tr>
<td>KJO Jansen</td>
<td></td>
</tr>
<tr>
<td>P Memelink</td>
<td></td>
</tr>
<tr>
<td>HJ Snijders</td>
<td></td>
</tr>
<tr>
<td>CJJM Stolker</td>
<td></td>
</tr>
<tr>
<td><strong>Book Title</strong></td>
<td><strong>Publisher</strong></td>
</tr>
<tr>
<td>Ex Libris Hans Nieuwenhuis</td>
<td>Kluwer</td>
</tr>
<tr>
<td><strong>Publisher</strong></td>
<td></td>
</tr>
</tbody>
</table>

---

11.6 **Encyclopaedias.**

- **Year field:** put the year of publication of the volume.
- **Title field:** put the title with capital letters for the major words.
- **Edition field:** put the edition of version/edition you are citing, using the form 2nd, 3rd, 4th etc. or rev for revised editions.

*Also use for:* any source that requires a title in italics but no author or publisher.

**Encyclopedia format for footnote:** Title (Edition, Year).

**Encyclopedia format for bibliography:** Title (Edition, Year)
11.7 **Hard copy journal articles – use the Journals reference.**

Use for all journals that are published in hard copy, even if you found the article online.

- **Author field**: put the author’s name in the form Susan D Smith or Smith, Susan D. If there is more than one author, put each author on a new line.
- **Year field**: put the year of publication of the article.
- **Title field**: put the title with capital letters for the major words.
- **Journal field**: put the journal full name or a suitable abbreviation (see below for more information about journal abbreviations).
- **Volume field**: put the volume number in numerals. If there is no volume number leave this field blank.
- **Issue field**: include the issue number only if the page numbers begin again for each issue within a volume, in which case put the issue number in brackets immediately after the volume number.
- **Pages field**: put the first page of the article here. It is also possible to enter the span of pages; only the first page will show in your references.
- **Short Title field**: if required for subsequent citations, enter a short title. This is probably only useful if you are citing several articles by the same author.

**VERY IMPORTANT NOTE:**

All article citations will appear with round brackets for the year. Journals that have no volume numbers require square brackets around the year. To do this, at the end of your work, de-link the references from Endnote (using Convert to Plain Text or Remove Field Codes) and replace the round brackets with square brackets as necessary.

An alternative way to get the desired result for journals references would be to remove the Year field from the Bibliography and Footnotes templates, and to include the year in square or round brackets as appropriate in the volume field in your Endnote Library.

**Journal article format for footnote**: Author_Firstname Author_Lastname, ‘Title’ (Year) Volume Journal Name/Abbreviation First page.

**Journal article format for bibliography**: Author_Lastname Author_Initials, ‘Title’ (Year) Volume Journal Name/Abbreviation First page.
### EndNote reference example: journal with volume number

<table>
<thead>
<tr>
<th>Author</th>
<th>JAG Griffith</th>
</tr>
</thead>
<tbody>
<tr>
<td>Year</td>
<td>2001</td>
</tr>
<tr>
<td>Title</td>
<td>The Common Law and the Political Constitution</td>
</tr>
<tr>
<td>Journal</td>
<td>Law Quarterly Review</td>
</tr>
<tr>
<td>Volume</td>
<td>117</td>
</tr>
<tr>
<td>Pages</td>
<td>42-67</td>
</tr>
</tbody>
</table>

Paul Craig, 'Theory, “Pure Theory” and Values in Public Law' [2005] PL 440 (in this example the round brackets have been changed ‘manually’ in Word to square brackets)

<table>
<thead>
<tr>
<th>Author</th>
<th>Paul Craig</th>
</tr>
</thead>
<tbody>
<tr>
<td>Year</td>
<td>2005</td>
</tr>
<tr>
<td>Title</td>
<td>Theory, “Pure Theory” and Values in Public Law</td>
</tr>
<tr>
<td>Journal</td>
<td>Public Law</td>
</tr>
<tr>
<td>Pages</td>
<td>440</td>
</tr>
</tbody>
</table>

### 11.8 Journal abbreviations.

OSCOLA allows use of either the full journal name or the journal abbreviation. If you have been told to use the abbreviations, use the Cardiff Index preferred abbreviation ([www.legalabbrevs.cardiff.ac.uk](http://www.legalabbrevs.cardiff.ac.uk)).

You could also use a Term List within EndNote to help you – a term list is a way of remembering standard formats for names, so you enter information consistently. See the OSCOLA Referencing Style tab on the Law Library Guide for more detail ([http://libguides.ncl.ac.uk/law](http://libguides.ncl.ac.uk/law)).

### 11.9 Electronic journal articles and working papers – use the Electronic Article reference.

- **Author field**: put the author’s name in the form Susan D Smith or Smith, Susan D. If there is more than one author, put each author on a new line.
- **Year field**: put the year of publication of the article (for your own reference only).
- **Title field**: put the title with capital letters for the major words.
- **Periodical Title field**: put the journal citation in full, including year of publication, volume or issue and journal name or abbreviation.
- **Date Accessed field**: put the most recent date of access in the form: 1 January 2011.
• **URL field**: put the web address of the paper, copied from the browser address bar. Look for the most succinct URL that will find the article and avoid long URLs that include search terms. Check that the URL works in a different browser.

• **Short Title field**: if required for subsequent citations, enter a short title.

If a pinpoint/page number is required in the footnote, use Cited Pages, which will insert the page number before the URL.

If the web address has a 'www' at the start, there is no need to write http:// at the start of the web address.

**Electronic journal article/working paper format for footnote**: Author_Firstname Author_Lastname, 'Title' (Year)/[Year] Volume/Issue Journal Name/Abbreviation First page/Number <web address> date accessed.

**Electronic journal article/working paper format for bibliography**: Author_Lastname Author_Initials, 'Title' (Year)/[Year] Volume/Issue Journal Name/Abbreviation First page/Number <web address> date accessed.

<table>
<thead>
<tr>
<th>EndNote reference example: electronic only journal</th>
<th>EndNote reference example: working paper</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Author</strong></td>
<td><strong>Author</strong></td>
</tr>
<tr>
<td>Graham GreenLeaf</td>
<td>John M Finnis</td>
</tr>
<tr>
<td><strong>Year</strong></td>
<td><strong>Year</strong></td>
</tr>
<tr>
<td>2010</td>
<td>2006</td>
</tr>
<tr>
<td><strong>Title</strong></td>
<td><strong>Title</strong></td>
</tr>
<tr>
<td>The Global Development of Free Access to Legal Information</td>
<td>On Public Reason</td>
</tr>
<tr>
<td><strong>Periodical Title</strong></td>
<td><strong>Periodical Title</strong></td>
</tr>
<tr>
<td><strong>Date Accessed</strong></td>
<td><strong>Date Accessed</strong></td>
</tr>
<tr>
<td>27 July 2010</td>
<td>18 November 2009</td>
</tr>
<tr>
<td><strong>URL</strong></td>
<td><strong>URL</strong></td>
</tr>
</tbody>
</table>
11.10 Conference papers

- **Author field**: put the author’s name in the form Susan D Smith or Smith, Susan D. If there is more than one author, put each author on a new line.
- **Title field**: put the title with capital letters for the major words.
- **Conference Name field**: put the title, location and date of the conference, with commas between each.

*Also use for*: any source that requires author, title in roman with quote marks, and information about the source in brackets.

**Conference paper format for footnote**: Author_Firstname Author_Lastname, ‘Title’ (Conference Name).

**Conference paper format for bibliography**: Author_Lastname Author_Initials, ‘Title’ (Conference Name)

<table>
<thead>
<tr>
<th>EndNote reference example: conference</th>
</tr>
</thead>
</table>

**Author**
Ben McFarlane
Donal Nolan

**Title**
Remedying Reliance: The Future Development of Promissory and Proprietary Estoppel in English Law

**Conference Name**
Obligations III conference, Brisbane, July 2006

11.11 Theses.

- **Author field**: put the author’s name in the form Susan D Smith or Smith, Susan D.
- **Year field**: year of submission.
- **Title field**: put the title with capital letters for the major words.
- **University field**: put the name of the university.
- **Thesis type**: put the type of thesis followed by the word thesis.
**Thesis format for footnote:** Author_Firstname Author_Lastname, 'Title' (Thesis Type, University Year).

**Thesis format for bibliography:** Author_Lastname Author_Initials, 'Title' (Thesis Type, University Year)

<table>
<thead>
<tr>
<th>EndNote reference example: thesis</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Author</strong></td>
</tr>
<tr>
<td><strong>Year</strong></td>
</tr>
<tr>
<td><strong>Title</strong></td>
</tr>
<tr>
<td><strong>University</strong></td>
</tr>
<tr>
<td><strong>Thesis Type</strong></td>
</tr>
</tbody>
</table>

**11.12 Websites and blogs – use the Web page reference.**

- **Author field:** put the author’s name in the form Susan D Smith or Smith, Susan D. If there is more than one author, put each author on a new line.
- **Year field:** put the date of publication of the webpage or blog.
- **Title field:** put the title with capital letters for the major words.
- **Publisher field:** put the website or blog name.
- **Date Accessed field:** put the most recent date of access in the form 1 January 2011.
- **URL field:** put the web address of the paper, copied from the browser address bar. Look for the most succinct URL that will find the article and avoid long URLs that include search terms. Check that the URL works in a different browser.

If the web address has a ‘www’ at the start there is no need to write http:// at the start of the web address.

**Website/blog format for footnote:** Author_Firstname Author_Lastname, ‘Title’ (date of publication) Publisher/website/blog name <web address> date accessed.
**Website/blog format for bibliography:** Author Lastname Author_Initials, 'Title' (date of publication) Publisher/website/blog name <web address> date accessed

<table>
<thead>
<tr>
<th>EndNote reference example: website</th>
</tr>
</thead>
</table>

**Author**  
Sarah Cole  
**Year**  
1 May 2009  
**Title**  
Virtual Friend Fires Employee  
**Publisher**  
Naked Law  
**Access Date**  
19 November 2009  
**URL**  
www.nakedlaw.com/2009/05/index.html

11.13 **Newspaper articles.**

- **Reporter field:** put the author's name in the form Susan D Smith or Smith, Susan D.
- **Title field:** put the title with capital letters for the major words.
- **Newspaper field:** put the name of the newspaper
- **Pages field:** put the page of the article, preceded by the section of the newspaper if relevant.
- **Issue date:** put the date of the newspaper in the form 1 January 2011.

**Newspaper article format for footnote:** Reporter, 'Title' *Newspaper* (Place published, date of issue) Section Page number <web address> date accessed.

**Newspaper article format for bibliography:** Reporter, 'Title' *Newspaper* (Place published, date of issue) Section Page number <web address> date accessed
### EndNote reference example: printed newspaper

Jane Croft, ‘Supreme Court Warns on Quality’ Financial Times (London 1 July 2010) 3

**Reporter**
Jane Croft

**Title**
Supreme Court Warns on Quality

**Newspaper**
Financial Times

**Place published**
London

**Pages**
3

**Issue Date**
1 July 2010

### EndNote reference example: online newspaper


<www.guardian.co.uk/commentisfree/2008/jun/19/justice.ukcrime> accessed 19 November 2009

**Reporter**
Ian Loader

**Title**
The Great Victim of this Get Tough Hyperactivity is Labour

**Newspaper**
The Guardian

**Place published**
London

**Issue Date**
19 June 2008

**Access Date**
19 November 2009

**URL**
www.guardian.co.uk/commentisfree/2008/jun/19/justice.ukcrime

### 11.14 Personal Communications.

Use for letters, emails, interviews, etc.

- **Title field**: put all relevant information and punctuation about the author (only required if someone else sent the letter or email or conducted the interview) and the description of the communication/interview itself.
- **Date field**: in the form 1 January 2011. (For interviews, put place and date.)

**Personal communications format for footnote**: Title (Date).

**Personal communications format for bibliography**: Title (Date).
11.15 **General Reference Type.**

Use for any reference that requires an author, the title in italics, bibliographic information about where the source (i.e., where it was published) and the year of publication.

- **Author field:** put the author’s name in the form Susan D Smith or Smith, Susan D. If there is more than one author, put each author on a new line.
- **Year field:** put the year of publication of the article (for your own reference only).
- **Title field:** put the title with capital letters for the major words.
- **Publisher field:** put relevant information about where the source was published.

**Generic format for footnote:** Author, *Title* (Publisher, Year).

**Generic format for bibliography:** Author, *Title* (Publisher, Year)

---

**Section 12: Making changes to the OSCOLA output style.**

In EndNote, go to **Edit**, then **Output Styles**, and **Edit OSCOLA_4th_edn**.

To stop the bibliography building in your document as you write, go to **Footnotes > Templates** in the left-hand menu and untick ‘Include citations in bibliography’ then Save this style.

To produce a bibliography at the end of your work, go to **Footnotes > Templates** in the left-hand menu and tick ‘Include citations in bibliography’. Refresh your document using the **Update Citations and Bibliography** button within the EndNote toolbar in Word.
To stop subsequent mentions of a citation in your footnotes from using the author only, Short Form of the citation, and/or ibid, make the relevant changes in Footnotes > Repeated Citations in the left-hand menu.

Section 13: OSCOLA bibliography templates.

Follow the online EndNote Help manual available from Clarivate Analytics if altering any templates.

13.1 Footnote templates.

The footnote templates are the same as the bibliography templates with the following exceptions:

Author names are Forename Surname in the footnotes but Surname, Initials in the bibliography.

The Cited pages field is added at the end of the footnote templates.

The Cases template has Call number (for ECJ case numbers) at the beginning: Call Number Case Name Reporter| (Court)| Cited Pages.

Section 14 OSCOLA’s Quick Reference Guide.

14.1 Primary sources.

Do not use full stops in abbreviations. Separate citations with a semi-colon. End footnotes with a full stop; omit these within your bibliography.

14.1.1 Cases.

Give the party names, followed by the neutral citation, followed by the Law Reports citation (e.g. AC, Ch, QB).

If there is no neutral citation, give the Law Reports citation followed by the court in brackets.

If the case is not reported in the Law Reports, cite the All ER or the WLR, or failing that a specialist report.

• *Page v Smith* [1996] AC 155 (HL)

When pinpointing, give paragraph numbers in square brackets at the end of the citation. If the judgment has no paragraph numbers, provide the page number pinpoint after the court:

• *Callery v Gray* [2001] EWCA Civ 1117, [2001] 1 WLR 2112 [42], [45]
• *Bunt v Tilley* [2006] EWHC 407 (QB), [2006] 3 All ER 336 [1]–[37]
• R v Leeds County Court, ex p Morris [1990] QB 523 (QB) 530–31

If citing a particular judge:

• *Arscott v The Coal Authority* [2004] EWCA Civ 892, [2005] Env LR 6 [27] (Laws LJ)

If one judgment is citing another judgment, cite the first case, followed by ‘citing’ and then cite the second case:


14.1.2 Statutes and Statutory Instruments.

• Act of Supremacy 1558
• Human Rights Act 1998, s 15(1)(b)
• Penalties for Disorderly Behaviour (Amendment of Minimum Age) Order 2004, SI 2004/3166

14.1.3 EU Cases.

Treatment of the European Case Law Identifier will be discussed and included in the 5th edition of the OSCOLA Guide when published. If you wish to include the ECLI when citing cases from the Court of Justice of the European Union then treat it as a neutral citation, adding it after the case name and before the report citation.

Original citation:


Citation including ECLI:


For unreported cases, cite the ECLI rather than the OJ notice or the court and date (as advised above and in OSCOLA 2.6.2):

• Case C-542/09 Commission v the Netherlands EU:C:2012:346
14.1.4 EU Legislation.

From 1 January 2015 onwards, the number of EU legislation has changed, and that under the new approach EU legislation will bear a unique, sequential number. This number should be cited in the form: (domain/body) YYYY/no

Original citation:

Revised citation:

The numbering of documents published before 1 January 2015 remains unchanged.

14.1.5 European Court of Human Rights.

- Omojudi v UK (2009) 51 EHRR 10
- Osman v UK ECHR 1998–VIII 3124
- Balogh v Hungary App no 47940/99 (ECHR, 20 July 2004)
- Simpson v UK (1989) 64 DR 188

14.2 Secondary sources.

14.2.1 Books.

Give the author’s name in the same form as in the publication, except in bibliographies, where you should give only the surname followed by the initial(s). Give relevant information about editions, translators and so forth before the publisher, and give page numbers at the end of the citation, after the brackets.

- Thomas Hobbes, Leviathan (first published 1651, Penguin 1985) 268
- Gareth Jones, Goff and Jones: The Law of Restitution (1st supp, 7th edn, Sweet & Maxwell 2009)
- K Zweigert and H Kötz, An Introduction to Comparative Law (Tony Weir tr, 3rd edn, OUP 1998)
14.2.2 eBooks.

If the eBook is the same format at the printed publication, with the same page numbering, cite the eBook as if it was the printed book.

If the eBook has no page numbers, following the normal book or edited book citation form, including the eBook type/edition before the publisher.

For pinpoints where there are no page numbers, provide the chapter or section number (or section name, if a number isn’t provided) and subsection or paragraph number if provided.

- *Williams on Wills* (9th edn, LexisLibrary edn, Lexis Nexis 2007) vol 1, part F, para 23.1
- Jill E Martin, *Hanbury & Martin Modern Equity* (19th edn, Kindle edn, Sweet & Maxwell 2012) ch 1, part 2E, 1-008, text above n 24
- William Lucy, *Philosophy of Private Law* (Kindle edn, OUP 2007) ch 1, text above n 16

14.2.3 Contributions to edited books.


14.2.4 Book reviews.

Cite a book review in the same way as a journal article, but without the quote marks.


14.2.5 Encyclopaedias.


14.2.6 Dictionaries.

Follow the examples given for Encyclopaedias (OSCOLA 3.2.6).

- ‘philosophy, n’ (*OED Online*, OUP June 2013)
14.2.7  Journal articles.

- Paul Craig, 'Theory, “Pure Theory” and Values in Public Law' [2005] PL 440
  When pinpointing, put a comma between the first page of the article and the page
  pinpoint.


14.2.8  Online journals.

  2010

14.2.9  Command Papers and Law Commission Reports.

- Department for International Development, Eliminating World Poverty: Building
  our Common Future (White Paper, Cm 7656, 2009) ch 5

- Law Commission, Reforming Bribery (Law Com No 313, 2008) paras 3.12–3.17

14.2.10  Websites and blogs.

- Sarah Cole, ‘Virtual Friend Fires Employee’ (Naked Law, 1 May 2009)

14.2.11  Newspaper articles.

- Jane Croft, ‘Supreme Court Warns on Quality’ Financial Times (London, 1 July
  2010)

14.2.12  Podcasts, YouTube, etc.

Follow the general principles for 'Other secondary sources' (OSCOLA 3.4.1) suggesting
the following form for citing podcasts, YouTube videos and other similar sources:

- Author, ‘Title’ (publication date) <URL> accessed DD month YYYY

This OSCOLA Quick Reference Guide is reproduced with permission.
Sandra Meredith, Law Faculty, University of Oxford: www.law.ox.ac.uk/oscola